
Morpheus Photo Animation Suite™

Reviewer’s Guide
The all-in-one animation suite includes Morpheus Photo Morpher, 
Morpheus Photo Warper, Morpheus Photo Mixer, as well as all 15 
sample morphs, warps, and mixes. 

Included in the Reviewer’s Guide:

•  Screenshots
•  FAQ

Tutorial

To view the tutorial for the individual products which make up Morpheus Photo Animation Suite (Morpher, 
Warper and Mixer), please view the Reviewer’s Guides for those respective products.  There is no 
separate tutorial for Suite.

Screenshots



FAQ

1. What is Morpheus Photo Animation Suite?
Morpheus Photo Animation Suite is an award-winning graphics program that lets you create animations of photos 
or movies morphing from one to another, being warped and distorted, or create mixes of characteristics from two 
photos. Morpheus Photo Animation Suite lets you create morphs in Flash SWF, Animated GIF, AVI, JPEG, PNG, 
TIFF, and other popular formats. It is easy, fast, and fun to use for both beginning and advanced users. There is a 
beginner mode and tutorial to help you get started quickly. Sample morphs come included as well, which can be 
used as another way to quickly learn the program. 

2. How do I get started using Morpheus Photo Animation Suite?
You can view the tutorial first (recommended) or just start using the program and play around with the sample 
morphs. Morpheus Photo Animation Suite has a very intuitive interface which is fairly easy to learn. Make sure 
you leave the beginner mode menus option on while learning how to use Morpheus Photo Animation Suite. 
For more detailed information on the program's features, please see the help files. If you have trouble using the 
program after reviewing the tutorial and the help files, feel free to visit our support forums and we'll do our best to 
help you understand the program better. 

 3. What are beginner mode menus?
By default, Morpheus Photo Animation Suite will use beginner mode menus, which will hide all but the bare 
essential menu choices needed to create a simple morph. For most users, we suggest starting out by leaving the 
program in beginner mode and moving up to normal mode once you are comfortable with the program. For 
power-users and/or image professionals, you might want to use normal mode right away.
 
You can easily use the normal mode menus by unchecking the beginner mode menus checkbox from the layout 
wizard which appears when you first start Morpheus Photo Animation Suite. You can also set this option in the 
program's preferences window, available under the Edit menu. Normal mode will show all available menu options 
needed in order to use more of the program's features and to create more complex morphs. 

4. Why are some of my dots the same color?
In the normal mode of Morpheus Photo Animation Suite, you can change the color, style, and size of the dots 
under by selecting Customize Dot's Default from the Morph menu. 
There are a number of different schemes to choose from, which provide a variety of colors, let you pick a solid 
color for all of the dots, or even inverse the picture underneath the dots. The color, style, and size of the dots are 
up to you, but they will be easier to see if you pick a color scheme where the dots have more contrast to the 
pictures you are working with.
 
In beginner mode, you are fixed with the default color scheme, which cycles 8 basic colors across the dots. Note 
that the 9th dot you add will therefore be the same color as the 1st, the 10th the same as the 2nd, and so on. To 
tell the dots apart and to correctly locate their partner dot, simply move your mouse over one to highlight it. Its 
partner dot will then glow as well. 

 5. What is the best way to view my morph when I am finished?
When you have finished creating your morph you can view it for yourself right inside the program in the preview 
window. Simply press the play button to watch your animation. 
In order to use your morph in other programs, put it on a website, or email it to a friend, you must first render it to 
a file. Rendering your morph creates a standard file type which can be displayed in other programs, but it cannot 
be edited in Morpheus Photo Animation Suite in the future. Select the Render Timeline option from the File menu 
and you will be able to render your morph to a variety of movie formats such as AVI, Flash SWF, or Animated 
GIF, or a series of still images.
 
There is also an easy to use wizard which can assist you in emailing your morph to a friend. Select "Email your 
morph to a friend" from the Share menu and you will be guided through a few quick steps. 



6. What formats can I render my morphs in? Which is the best?
Movie Files: These formats save the entire morph as a single animated file.
 
•  Compressed AVI: Use any installed Windows DirectShow or Video for Windows Codec to compress your 
movies for smaller files.
•  Uncompressed AVI: Perfect quality movie, very large, good for importing into movie editing software such as 
Adobe Premiere.
•  Flash SWF: Best for display on webpages, very small and high quality, and supports full translucency.
•  Animated GIF: Good for webpages, every browser can view them, but images are only 256 color, and thus 
limited to lower quality.
Picture Sequences: These formats save each frame of the morph as an individual file. 
•  PNG: Perfect quality images, small file size, and supports full translucency.
•  JPEG: Very small files good for webpages, but quality poor at higher compression settings.
•  TIFF: Perfect quality images, large like bitmaps.
•  BMP: Perfect quality shot of every frame, but very large files.
•  TGA: Perfect quality, large, but supports translucency in more programs.
•  XPM: Larger than all other formats, but useful for importing to Linux systems.

Which file type is the best depends on what you want to do with your morph. If you are unsure, you can try each 
of the formats and see how they work with the other programs you might want to use your morphs with. While 
Morpheus Photo Animation Suite can create any of these standard file types, not all third party applications will 
be able to display files in every one of the available formats. 

7. What do I do with my completed morphs?
Use your morphs to grab people's attention or to have a good time - create web graphics and enhance your web 
site, email morphs to friends and family to make them laugh, create a unique online greeting, post your morphs 
on the Internet, add more life to your presentations, or use your morphs in countless other great ways!
 
If your morph is unique and exciting, and you want to share it with other Morpheus Photo Animation Suite users, 
you might consider submitting it to us for display. 

8. How can I email my morph to a friend?
You can email your animations using the built-in email feature by selecting "Email your morph to a friend" from 
the Share menu in the program. The Send Morph Wizard will appear, allowing you to fill in your From address 
and any number of To addresses of your friends. Once both boxes are filled in with valid email addresses, you 
can press the Next button to proceed to the next page where you will select the type of file to send in the email. 
After you select the file type and press Next, your animation will be rendered in order to prepare it for emailing. 
On the last page of the wizard, simply press the Send button and your email will start sending. Please be patient 
as it sends as large animations may take longer to send.
 
You can also render the timeline to a file of any type, and remember the location where you created the file. 
Attach that file to an email in your regular email program just like you would any other file you wanted to send. It 
is recommended that you render a file type which will be small in size so the emails can be sent quickly, such as 
JPEG or an AVI compressed with an MPEG-4 codec such as DivX or XviD. 

 9. I have another question not asked here. How can I contact Morpheus Software?
Please run through the tutorial, read through the help files, and play around with the variety of sample morphs 
that come included with Morpheus Photo Animation Suite. After trying those options, if you are still unable to 
resolve your issue, please visit our support forums and we will do our best to assist you in making your experi-
ence with Morpheus Photo Animation Suite a great one. 

10. How do I turn one person into another?
Creating an animation of one person transitioning into another is called a morph, and morphing is exactly what 
Morpheus Photo Animation Suite is designed to do. Please see the tutorial for step-by-step directions on creating 
a morph. 



11. How do I distort a picture of somebody?
Creating an animation which distorts a picture of a person is called a warp, and warping is another thing that 
Morpheus Photo Animation Suite is designed to do. Please see the tutorial for step-by-step directions on creating 
a warp. 

12. How do I put somebody's head on somebody else's body?
Creating a picture which uses features from two different pictures mixed together is called a photo mix, and 
mixing is another thing that Morpheus Photo Animation Suite is designed to do. Please see the tutorial for 
step-by-step directions on creating a photo mix. 

13. Can I morph more than two pictures?
Yes, you can easily morph more than two pictures. The layout wizard which appears when you start Morpheus 
Photo Animation Suite can guide you through loading as many pictures as you want and have them morph from 
one to another in the order you choose.
 
To later add additional pictures to an existing morph, simply select "Add morph" in the Timeline window, and an 
extra morph will be added. Doubleclick on the morph buttons in the Timeline window to open any two picture 
windows side by side. You can then easily use the "Load Picture" button to load a new picture or change the 
existing picture for any picture window. 

14. Why do my pictures look squished in the Preview window?
Morpheus Photo Animation Suite automatically sizes your timeline based on the sizes of the pictures you load. It 
is not a problem to load pictures with different dimensions, but if you load two pictures with different aspect ratios, 
or manually set a different size for your timeline, then some pictures may look squished in the Preview window. 
Morpheus Photo Animation Suite will stretch all pictures to fill the timeline size and since it does not cut off any of 
the edges of the pictures, some may appear squished vertically or horizontally in order to fit.
 
It is recommended to use pictures of similar aspect ratios by cropping them to the portions you want. You can use 
the Picture Layout option to change how the picture appears in the morph area. This will allow you to adjust the 
aspect ratio and stretching of the pictures as well as effectively crop parts of the pictures to be unused. 

15. What are the best size pictures to use?
It is recommended to use pictures of the largest dimensions you can, since you can easily zoom in and out to 
place dots at precise locations better when there are more details with which to zoom. Keep in mind the aspect 
ratio of your pictures though. If, for example, one picture is 1000x1000 pixels, but another is 1000x800 pixels, 
then the second picture may look stretched in order to match the aspect ratio used by the entire timeline. Larger 
picture dimensions also allow for more clarity when parts of your morph are stretched larger. 

16. Can I add dots to just one picture individually?
Every dot you add to one picture will automatically get a corresponding partner dot on the opposite picture. Dots 
only come in pairs, because the purpose of a dot is to match up key features in each picture to tell Morpheus 
Photo Animation Suite how the starting picture will morph into the ending picture. 

17. I closed the picture windows. How do I get them back?
In the Timeline window, simply doubleclick on any of the picture thumbnail buttons to open that picture window so 
that you can adjust the dots on it. The morph buttons just above the picture buttons will open both pictures for 
that morph side by side when double clicked.

If you do not see the Timeline window, it may be hidden. Select Timeline from the View menu to toggle showing 
and hiding the Timeline window. 



18. What are the three different applications included with Morpheus Photo 
Animation Suite?
Morpheus Photo Animation Suite combines all of the features of morphing, warping, and photo mixing into one 
application. There are not three separate programs installed with Morpheus Photo Animation Suite, and because 
of this, you can use Morpheus Photo Animation Suite to create morphs and warps together on the same timeline. 

19. What is the difference between a morph, a warp, and a photo mix?
A morph is an animation of one person transitioning into another. A warp is an animation where one picture is 
stretched or distorted. A photo mix is a still picture which is created using parts taken from two other pictures. 
Morpheus Photo Animation Suite can be used to create all three of these since it combines the power of 
Morpheus Photo Morpher, Morpheus Photo Warper, and Morpheus Photo Mixer into one easy to use suite. 

20. How can I use my rendered animated GIF files in PowerPoint?
You can insert your animated GIF files into PowerPoint by selecting Insert / Picture / From File from the menu in 
PowerPoint, just like you would place any other picture file in your slideshow. Currently, no version of PowerPoint 
properly plays all animated GIFs like your web browser does. This is not a defect of Morpheus Photo Animation 
Suite or the animated GIFs it creates, but simply that PowerPoint does not properly obey the looping information 
stored in any GIF file. What's worse is that PowerPoint from each version of Microsoft Office behaves differently:
 
•  Office 2000 - All animated GIF files will loop forever. There is no way to stop the animation at the end. 
•  Office XP - Animated GIF files which should loop forever will act as they should. For files which are set to play a 
   certain number of times, PowerPoint plays the GIF one less time than it should. For files which are set to play 
   just once, PowerPoint will play them once and stop as it should. 
•  Office 2003 - Plays animated GIF files similar to Office XP, except that files which are set to play just once won't 
   play at all. They will instead remain on the first frame of the animated, paused forever.
 
If you would like your animated GIF files to play once and stop at the end, the safest way seems to be to set them 
to be played twice in Morpheus Photo Animation Suite and make sure that you view the slideshow in PowerPoint 
using Office XP or higher. However, it is possible that the next version of Office, after Office 2003, will start play-
ing these files correctly, and the same slideshow would thus repeat the animation twice in the future. 
Another thing you may want to do in PowerPoint is have your animation showing the first picture, and have a click 
begin the animation. This can most easily be accomplished by creating two similar slides, where the first slide 
actually uses a still picture, and the next slide has the animated GIF in the same location. If all other text in the 
two slides is the same, the click between the two slides will give the appearance of starting the animation. 

21. What is a codec and which one should I use?
A codec is a "Compressor / Decompressor" and it is what is used to compress AVI files in order to make them 
smaller. Nearly all AVI files are compressed with some codec, but they do not always use the same codec. In 
order to play back an AVI, you must have the codec installed which was used to compress it, or you will be 
unable to decompress it for viewing.
 
Morpheus Photo Animation Suite allows you to compress AVI files with any codec installed on your system, as 
well as set the various configuration parameters these codecs use. Some codecs are much better than others 
and the better ones can not only result in higher quality videos, but smaller files as well. The latest generation of 
MPEG-4 codecs such as DivX and XviD are recommended because they have one of the best combinations of 
small file size and high quality video. You can use any codec you like, but keep in mind that anybody who needs 
to view the AVI you create would need to have that same codec installed, and not many high quality codecs come 
pre-installed with Windows. 

22. How can I make my animation wait at the beginning or the ending longer?
Each morph in your timeline can be set to hold for any duration for the starting and ending pictures. Simply select 
Morph Options from the Morph menu and enter any number of seconds in either "Time to hold for at start" or 
"Time to hold for at end". You can also set your animation to stay on the last picture forever by setting the "Loop 
morph" setting in the Timeline Options to "Stop after the first time."  



24. Why does my AVI file go back to the starting picture after the animation plays?
Whether or not it will rewind the movie when it is finished playing depends on the AVI player.  In new versions of 
Windows Media Player, there is no way to change the default behavior. If the Repeat option is off, Windows 
Media Player will play the movie through once, then automatically rewind it back to the first frame. In Windows 
Media Player 6.4, you can adjust this option by checking "Rewind when done playing" from the options menu.

25. How does the Fade Selected Dots button work?
By default, in a photo mix the entire mix is a blend of both the starting and ending picture. Each dot can be set to 
use the picture colors entirely from one picture by selecting start or end from the Fade Selected Dots button when 
you have one or more dots selected. Morpheus Photo Animation Suite automatically creates smooth mixes by 
blending between each dot set with different fade settings.
 
If, for example, you wanted to blend the head from the starting picture onto the body from the ending picture, you 
would select all of the dots placed around the head on the pictures and select Start from the Fade Selected Dots 
button, then select End for the dots around the body. Some dots in between the head and the body on the 
pictures, such as around the neck, can be set to Blend if you want a smoother transition. 

26. How can I keep transparency in my rendered files?
By default, Morpheus Photo Animation Suite renders 24bit truecolor images for each frame, You can render a 32 
bit image for every frame by selecting the "Morph the alpha channel" option in the Timeline Options window. 
If you wish to keep the entire alpha channel information in tact, you should set the "Transparent threshold" to 0.
 
The best format for keeping the entire alpha channel is to render to Flash SWF. For animated GIF files, it is 
recommended to set "Transparent threshold" to 128 so that any pixel less than 50% transparent will become the 
single transparent color index. If rendering to a series of still images, PNG is the best format for keeping the 
alpha channel intact. PNG files will blend properly into any background within any major web browser.
 
Uncompressed AVI files will store the alpha channel information in the file, and some codecs for compressed 
AVIs may as well, but most AVI viewers will not use this information. If you are using a movie editing program and 
importing the AVIs for further processing, the alpha channel information may be useful depending on which movie 
editing program you are using. 

27. What happened to the dot delay option?
Morpheus v1.85 featured a dot delay option which controlled the time a dot would start and stop moving and 
fading, where the dot would stand still entirely faded towards one picture before and after the set times. In 
Morpheus Photo Animation Suite v3.00, this is replaced by a much more powerful combination of key frames and 
fade graphs. Dot delay saved in layout files from Morpheus v1.85 will be imported and converted to the new 
features automatically.
 
To define a time period where dots don't move, you simply need to add one key frame to the timeline. Then copy 
and paste the dot locations from the picture window to the key frame window, so each dot is in the same location. 
The fade graphs can then adjust the dots on each key frame to fade between the pictures with any given amount, 
not just 0% or 100%. 

23. How can I make my animation play only once instead of repeating forever?
In the Timeline Options window, you can set the "Loop morph" to "Stop after the first time" instead of the default 
of "Loop forever." This will work for Flash SWF as well as animated GIF files. If you render your morph to an AVI 
file, this option has no effect because the AVI file format does not have any way to specify the number of times 
the file should loop. Whether or not the movie loops depends on the AVI viewer.
 
In newer versions of Windows Media Player such as 9 or 10, you can simply select Repeat from the Play menu to 
toggle looping on and off. In Windows Media Player 6.4 there are playback options under View / Options where 
you can adjust the number of times a movie file should loop. 


